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Features Overview

Simplified installation and setup
●  Installation changes
●  AE healthiness check
●  Scheduled server checks
●  Reliable overview of my databases in server admin
●  Database maintenance - Rebuild index
●  Improved UI for database configuration
●  About page in Server Admin with installation and hotfix information
●  Include screens data in the AE backup
●  Improved UI for troubleshooting container issues
●  SQL2014 as default database engine
●  Simplify installation with an existing full SQL server
●  Simplify migration of HotFolders to Folder Access Points
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Features Overview

General Performance
●  View native ArtPro files (no conversion to Normalized data)
●  Improved task cleanup rules
●  Improved database performance (also with 2008)
●  Improved Pilot performance (Avoid ‘dead’ Pilot)
●  Improved file download
●  Support for large XML files in the XPath builder 

Workflow tools
●  Launching workflows via HTTP using synchronous communication
●  Make Sync and Submit Workflow in WCR possible outside 
●  Select and Remove job in a workflow
●  Restore job task in a workflow
●  Remove product task
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Features Overview

CAD automation
●  Create CAD sheet task improvements: nest using products + simplified station location
●  Run CAD standard task
●  CAD S&R tasks use bleed priority info in MFG from ArtiosCAD
●  Shrink support in Create CAD sheet tasks
●  Load structural file
●  CAD sheet XML based on products

Gang run printing
●  Roll support in gang run printing
●  Overrule substrate rotation in submit to gang run
●  Extend content option in the prepare graphics for nesting task
●  File info on jobs in the gang run printing view
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Features Overview

Imposition automation
●  New Change Imposition Layout Task
●  Re-center pages on trim box

Various features
●  Grids in workflow canvas
●  Load Parameters for Repeating Content from XML in Map Data task
●  Improved UI for the Data Splitter workflow control
●  Sort on modification date in the Sort workflow control
●  Improved handling of conditional queries in the Split XML task
●  Improved UI for deprecated task (aka soon outdated tasks)
●  Pitstop 13 support (from prerelease DVD 4 onwards)
●  Search in Job Parameters
●  Layer info for Adobe® PDF files
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System 
Requirements
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Database 

●  SQL Server 2005 
●  SQL Server 2008 
●  SQL Server 2012 
●  SQL Server 2014 

 
 
 
 

System requirements

Server 


●  Windows 2003
●  Windows 2008
●  Windows 2008 R2
●  Windows 2012
●  Windows 2012 R2



NEW 

Client 
 

●  Windows XP 
●  Windows 7 
●  Windows 8 
●  Windows 8.1 

 
●  Mac OS 10.6.x 
●  Mac OS 10.7.x 
●  Mac OS 10.8.x 
●  Mac OS 10.9.x 
●  Mac OS 10.10.x 

 

NEW 

https://wiki.esko.com/display/SystemRequirementsSource/Automation+Engine+14.1+System+Requirements+-+Server
https://wiki.esko.com/display/SystemRequirementsSource/Automation+Engine+14.1+System+Requirements+-+Client

SOURCE 



9 

Simplified installation 
and setup
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●  When installing Automation Engine, there’s a possibility now to configure an existing (full) SQL 
Server instance for the Automation Engine databases so you don’t need to go through the 
Express Edition prerequisite installation and a reconfiguration phase afterwards.

Changes in the installation

2 options

Option 1: Install Automation 
Engine like you would do 
previously and then change the 
configuration of the Automation 
Engine databases to use another 
SQL Server instance. (and create 
the databases there and use the 
Synchronize button in configure 
to create the tables)

Option 2: Install Automation 
Engine like you would do 
previously, but without the SQL 
Server Express Edition 
prerequisite component. 

Note: fully implemented from 
prerelease DVD 5 onwards
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Server checks | Automation Engine healthiness check

●  A new “Server Checks” page is added to the Automation Engine Server Web Page called 
Health Check. There are currently 3 health checks available: Processor Cores, Memory and 
Tasks

Processor Cores
The number of processor cores is checked. The check determines if sufficient processor cores 
are present for the current AE setup.
Memory
The amount of memory (RAM) is checked. The check determines if sufficient memory is present 
for the current AE setup.
Tasks
The number of tasks is checked against some predefined thresholds. A check for old tasks is also 
performed. (old tasks are tasks that were launched more than 6 months ago) The thresholds are 
dependent upon the database version:
For an SQL express edition
Warning threshold: 30.000
Error threshold: 100.000
For all other database versions
Warning threshold: 200.000
Error threshold: none
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Server checks | Scheduled server checks

Introduction
●  Scheduled checks can be used to run the server checks that are available in the Server Checks 

section of the Server Admin page of the Automation Engine Server Web Page .
●  Scheduled checks will run automatically on the Automation Engine Server and will send reports 

when there are warnings or errors. 
How to set up and manage scheduled checks of the Automation Engine Server?
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Server checks | Scheduled server checks

●  To add a scheduled check, click the Add Scheduled Check button. The Add Scheduled 
Check dialog will pop up.
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Server checks | Scheduled server checks

●  Select the checks that should be run. Note: at least one check should be selected
●  Select the Frequency (Hourly, Daily, Weekly or Monthly) and the Start Time of the scheduled 

check.
●  Specify if you want the report to be sent on Warning, Error or on Error Only.
●  Specify the e-mail address or a semicolon-separated list of e-mail addresses the report should 

be sent to.
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Server checks | Scheduled server checks

●  This is an example of the report when there are warnings or errors:



Databases Check

FlexoPlates Database Scenario
Trying to log in to the default SQL Server instance on “localhost” for user “admin” failed. Verify that the user name and password you entered in Configure are 
correct and that the user has permission to connect.

For the latest situation, go to the Databases Check page of the Server Admin.

Containers Check

ExampleJobContainer3@twister
Could not connect to the Container “ExampleJobContainer3@twister” on “file://twister/ExampleJobContainer3”. Please contact your IT administrator.
Computer twister does not have a public IPv4 address.

ExampleJobContainer2@twister
Could not connect to the Container “ExampleJobContainer2@twister” on “file://twister/ExampleJobContainer2”. Please contact your IT administrator.
Computer twister does not have a public IPv4 address.

gdm_container@homer
Container “\\homer\gdm_container” is nearly full (76.1% used)

ExampleJobContainer@TWISTER
Could not connect to the Container “ExampleJobContainer@TWISTER” on “file://twister/ExampleJobContainer”. Please contact your IT administrator.
Computer twister does not have a public IPv4 address.

RND-SW-Tom-Gent@egsbe100
Container “\\egsbe100\RND-SW-Tom-Gent” is full (89.7% used)

ExampleJobContainer4@twister
Could not connect to the Container “ExampleJobContainer4@twister” on “file://twister/ExampleJobContainer4”. Please contact your IT administrator.
Computer twister does not have a public IPv4 address.

For the latest situation, go to the Containers Check page of the Server Admin.



16 

Server checks | Scheduled server checks

●  Example report continued…



Network Check

WebCenterConnection-ikbestaniet
The server “ikbestaniet” does not have a public IPv4 address. Please check its network settings or contact your IT administrator.
Computer ikbestaniet does not have a public IPv4 address.

DeviceConnection-rdvmaedfe01
The server “rdvmaedfe01” has multiple IPv4 addresses, which may cause connectivity problems. Please check its network settings or contact your IT 
administrator.
The computer rdvmaedfe01 has multiple IPv4 addresses : 10.31.224.57 : 20.31.224.57.

DeviceConnection-ScreenedOutput1
Could not connect to the Device “ScreenedOutput1” on “cssuite12a33” using port “3020”. Verify that this Device is running and accessible and that 
you entered the correct information in Configure.
Computer cssuite12a33 does not have a public IPv4 address.

DeviceConnection-CDI1
Could not connect to the Device “CDI1” on “cssuite12a1” using port “3100”. Verify that this Device is running and accessible and that you entered the 
correct information in Configure.

For the latest situation, go to the Network Check page of the Server Admin.
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Reliable overview of databases in server admin

The state of a full (local) SQL or external SQL server is now displayed correctly
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Database maintenance | Rebuild index

Basic database maintenance
●  New database maintenance actions in server admin so the general AE performance improves 

and/or remains as optimal as possible
●  To rebuild the indexes of an Automation Engine database go to the Maintenance section in 

server admin and click “Start Maintenance Now” or setup a “Maintenance Schedule”
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Database maintenance | Rebuild index

Basic database maintenance
●  You’ll get an indication that the system is busy doing maintenance. Click View details to get 

more live info.

IMPORTANT: Database performance could be affected while rebuilding indexes.  
Please schedule this when production is low or down (e.g. Sunday at 2 pm) 
and avoid taking backups at the same time.
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Database maintenance | Rebuild index

Extra information: What is a database index?
●  A database index is a data structure that improves the speed of data retrieval operations on 

a database table at the cost of additional writes and storage space to maintain the index data 
structure. Indexes are used to quickly locate data without having to search every row in a 
database table every time a database table is accessed.

●  The SQL Server Database Engine automatically maintains indexes whenever insert, update, or 
delete operations are made to the underlying data. Over time these modifications can cause the 
information in the index to become scattered in the database (fragmented). Heavily fragmented 
indexes can degrade query performance and cause Automation Engine to respond slowly. You 
can remedy index fragmentation by reorganizing or rebuilding an index.
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About page with installation and hotfix information

●  The About page of the Server Admin section of the Automation Engine Server Web Page is the 
place where you can find detailed information about the Automation Engine Server.

The About page shows the following 
information about Automation Engine:

•  The current version and build number, 

including the date the current version was 
created

•  The date the current version was installed
•  The list of installed hotfixes, including the 

date the hotfixes were installed
•  The installation history

For every hotfix that is installed, the following 
information is available:

•  The name of the hotfix
•  A short description of the hotfix
•  The product the hotfix applies to
•  The date the hotfix was created
•  The date the hotfix was installed
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Include screens data in the AE backup

Backup and restore screens
●  Screens are now included when making a backup that includes resources and/or databases. 

When restoring such a backup using the restore action Restore resources only, you can now 
also choose to restore screens separately.



Note: Only Imaging Engine screens are included,  
no FlexRip screens  
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Improved UI for database configuration

Select SQL Server Host and Instance from a list
●  When configuring a DBMS type database, e.g. "Microsoft SQL Server" (possible in “ArtiosCAD 

Servers", "Automation Engine Databases" or "External Databases"), the "Host" field now allows 
to pick the wanted host and instance combination from a list.
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Improved UI for troubleshooting container issues

Some scenarios
●  Creating a new Container fails because the BGSYSTEM password doesn't match
●  A Container is no longer accessible because BGSYSTEM doesn't have full access

●  A Container is offline in the “Containers view”. Why is it offline? New! Get Info on a Container
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Simplify Migration of HotFolders to Folder Access Points

●  It is now possible to export the ticket from within the hotfolder setup dialog. To export a ticket, 
open the “hotfolder” settings and choose "Export Ticket...". This will present the user with a 
save as dialog.
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General performance
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View native ArtPro files (non Normalized data)

●  The Automation Engine Viewer now has two modes for viewing ArtPro files.                         
The desired mode can be setup in Configure/Viewer.


View ArtPro files as in ArtPro
ArtPro files view or Prepare for View similar as in 
ArtPro. Placed ArtPro files are viewed using their 
preview image if available in the ArtPro file. This 
compatibility setting is usually faster but less 
accurate.
Note: The setting “Merge Similar Inks” has no effect when using 
the ArtPro compatibility mode.

View ArtPro files as in PackEdge
ArtPro files view or Prepare for View similar as in 
PackEdge. This compatibility setting is usually slower 
but more accurate.
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Improved task cleanup rules

●  Having the ability to cleanup tasks in a more precise way, makes it easier to keep the task 
monitor size under the recommended limit of 30.000 tasks.

●  Example: a preflight workflow can be cleaned up 1 day after finished date. The prepress 
workflow I'd like to keep for 5 days after finish date. I only want to archive my RIP workflows, 
they can be archived 1 day after finished date (as the job typically is finished). 

The Task Cleanup rules are now located in a different 
place in configure. They used to be available as a 
dedicated entry labeled "Task Cleanup Rules".
Note: Existing configured filters are automatically 
converted into new style filters.
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Improved task cleanup rules

●  The conditions can be previewed by clicking on "Preview Search Result”. The preview window 
allows the user to make changes to the conditions.

Note: Creating custom rules should be done with care 
as this can have a serious impact on performance.
Advised to hit the restore defaults button and adapt 
the number of days.
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Improved Pilot performance 

●  When a workstation goes into sleep / hibernate mode, it may happen that the network 
communication is switched off on system level to save power. When waking up again, the Pilot 
was unable to re-establish its open network connection that keep the views alive and 
updated in accordance to server activity (typically f.i. progress in the tasks view). 
A clear message is now popping up and the user has the possibility to either Relaunch or Quit 
the application.
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Improved file download 

●  The “uploading file” dialog is no longer blocking the Pilot. Multiple uploads are grouped 
together. 
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Support for large XML files in the XPath builder

●  When using the XPath builder to generate an XPath expression and you want to use/load the 
contents of an example XML file, a clear error message is given now: 

●  It is now possible to use/load the contents of XML files that are larger than 20KB.
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Workflow tools
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Launching workflows via HTTP using synchronous communication 

●  Web service access points can be configured to use synchronous communication. When 
using synchronous communication, every time an HTTP request is received on the URL 
specified by the web service access point, the Automation Engine Web Service will wait for the 
workflow to be finished before sending an HTTP response.                                                                         
Note: some of the Automation Engine Server's processing channels should be reserved for processing the 
incoming HTTP requests. This can be done in “Server Setup” of the Automation Engine Server Web Page .



35 

Launching workflows via HTTP using synchronous communication 

Setting the number of reserved processing channels in Server Admin
●  When using synchronous communication, some of the Automation Engine Server's processing 

channels should be reserved for processing the incoming HTTP requests.               
Note: the number of reserved processing channels has to be lower than the total number of processing 
channels.
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Sync and Submit Workflow in WCR possible outside LAN

●  It’s now possible to submit and sync workflows on Automation Engine when Automation Engine 
and WebCenter are NOT in the same LAN
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Select and Remove job in a workflow

Select Job
●  The Select Job workflow control can be used to select a job folder in a workflow. You can 

choose to select a job folder using the Job name or using the combination of the Order ID and 
sub order ID.

The Job Name, Order ID and Sub Order ID 
can be specified by

•  Entering a value
•  Inserting a SmartName
•  Selecting a job using the Select button
•  Entering an XPath expression and/or 

create an XPath expression

Data splitter
Note: the Select Job workflow control only handles 
one input file at the time. Use a Data Splitter if you 
want to select the jobs of multiple input files
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Select and Remove job in a workflow

Remove Job
●  The Remove Job task can be used to remove a job and to convert the job folder to a normal 

folder. It’s also possible to delete the files and folders.
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Restore job task in a workflow

●  The Restore Job Task can be added to a Workflow, but only has the error output pin (similar to 
the Create Job Task inside a Workflow). In the Restore Job Task ticket, you can specify that you 
want to launch a Workflow after the Job has been restored. This Workflow will run in the 
context of the restored Job.

Job Context
The Restore Job task inside a 
Workflow only has an error pin, 
because otherwise you would 
expect that the tasks following the 
Restore Job task would run in the 
context of the Restored Job.     
This is not possible since all tasks 
inside a Workflow run in the 
same Job as the Workflow.
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Remove product task 

●   A new task that gives the user the possibility to delete Products that are not relevant anymore 
for production as this fills up disks and makes managing the database more difficult.            
This action should be possible from within a business system so a manual cleanup is not 
needed. The task can also find products based on selecting their part(s) and then remove the 
complete product. (and all of its parts..)
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CAD automation
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Run ArtiosCAD standard task

●  The Run CAD Standard task allows to create an ARD design document based on the standard 
name, board code, board description, grain direction, units and standard variables as 
provided in an input XML file or direct input to those fields.
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Run ArtiosCAD standard task
Parameters for Run CAD Standard task

Attribute Description

Output in Specify the folder location, where the ARD file should be created.

File Name Specify the name of the ARD file that should be created in the output folder.

ArtiosCAD Server(*) Select the configured ArtiosCAD server. It supports both ArtiosCAD standard and enterprise 
servers.

Configure Click on configure button to configure the ArtiosCAD server.

Standard Name(*)  Click on the Select button to set the Standard Name (extension is important!)

Select When the ArtiosCAD Server is 'None', then this button is disabled. Based on the type of 
ArtiosCAD server, this dialog will look differently for these scenarios.

Board Code(*)  Specify the existing ArtiosCAD board code by using the smart name or XPath.

Board Description(*)  Specify the existing ArtiosCAD board description by using the smart name or XPath.

Grain Direction Select the grain direction. Default value is Vertical.

Units Select the metrics. Default value is mm.

Print Side Select the print side. Default value is inside.

Command Script Specify the command script which has to be executed after design creation.

Standard Variables(*)  Standard Variables define the dimensions (and other characteristics) of the CAD object. They 
can be defined by:
•  From XML File - Extracting the name and value from the XML file
•  Define Variables - Defined by the user (input via SmartNames, direct input ...).

(*) = mandatory elements.
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S&R tasks use bleed priority info in MFG from ArtiosCAD 

●  In case of MFG layouts, the artwork panels in ArtiosCAD can define a bleed direction.   
Artwork panels in ArtiosCAD now have an 'Allow bleed' property - if this property is turned ON, 
the panel is considered as having a minor priority and it can receive bleed when it touches 
another panel marked as major priority ('Allow bleed' not defined or turned OFF). In case 2 
minor panels are touching, bleed will be truncated to the centerline. 

●  This changed behavior applies to all S&R tasks and Plato.

Note: the ‘Allow bleed’ property is 
available from ArtiosCAD 14.0.2 onwards
Please check this document for 
detailed info:
https://esko.box.com/SmartFlapping
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Shrink support in Create CAD sheet tasks 

●  When writing a Normalized PDF file (self-contained PDF file or a PDFPLA) file, the shrink 
factors are written in the file's XMP section (i.e. the objects and page boxes will keep their 
original sizes). These shrink factors will be picked up by the RIP or Export to PDF file tasks 
where they will result in a scale factor (in vertical and horizontal direction) which are applied on 
the complete document (including page boxes).

●  When writing an Adobe PDF file, the shrink factors will result in a scaling which is applied on 
the complete document, including PDF page boxes (i.e. the objects will get scaled).
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Load structural file

●  With this task you can place a structural file, starting from a PDF file so that 'the marriage' 
between graphic file and structural file can happen automatically in the background without 
human intervention. This allows time saving for the operator who normally needs to place the 
structural file manually. The risk of choosing the wrong structural file is also gone. The output 
of the task is also the perfect input file for full automation of 3D samples.
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Load structural file

●  Input is a Normalized or Adobe PDF file (Adobe PDF files will get normalized on-the-fly).
●  If the input file already contains a structural object (loaded in PackEdge/ArtPro/DeskPack - 

only in case of normalized PDF files), the task will result in an error.
●  The structural file can be:

–  a CAD file (ARD / CF2 / DXF format)

–  a .bag file
–  a Collada file (.DAE / .ZAE format)

●  Loading the structural file will result in 
a Normalized PDF file containing a 
structural object.

●  The structural object will be 
positioned on the selected page 
box (Art/Crop/Bleed/Trim/Media 
Box). In case the dimensions 
(bounding box) of the structural 
object does not match with the 
size of the selected page box, a 
warning will be issued.
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Gang run printing
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Roll support in gang run printing 

●  When adding a new substrate queue, one can select whether the queue will contain 'Sheet' or 
'Roll' substrates (note: roll & sheet are a property of the queue - you can not mix sheet and roll 
substrates in the same queue)
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Roll support in gang run printing 

●  In the case of roll substrates, one can 
define: 

-  The width of the web (across the roll)
-  A min. and max. length (along the roll)
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Roll support in gang run printing 

●  Nesting on roll will:
-  Always set the 'Primary Fill Direction' 

or 'First Cut' to the direction across the 
roll

-  Reject jobs which exceed the 
maximum length (these jobs can't fit on 
the substrate)

-  Generate a layout in case the layout 
exceeds the minimum length and 
reaches the minimum fill percentage

Note: in case the due date has expired, a 
layout will be generated even if the minimum 
fill and length is not reached
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Roll support in gang run printing 

●  In case the PDF file for printing needs a 
different orientation, there is now a 
rotation option in the 'export nested 
layouts' task


Note: The orientations in the definition of the 
substrates (and the resulting nested file) are seen 
from the point of view of the (Kongsberg) table 
operator: the width of the web corresponds to 
the Y-direction of a Kongsberg table, so the 
height of the resulting layout. The length along 
the roll corresponds to the X-direction on a 
Kongsberg table = the width of the resulting 
layout.
Note: The 'Import Substrate Sizes from XML' has 
support to define roll substrates
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Overrule substrate rotation in submit to gang run

●  The ‘submit to gang run task’ has an additional control to set the rotation of the graphic. 
Possible values are:

•  Queue setting : use the rotation 
settings as defined in the gang run 
queue

•  Any angle: allow any angle (overrules 
the gang run queue settings)

•  0, 90, 180, 270: apply a fixed rotation 
angle (overrules the queue settings) - 
value is in degrees, clockwise

Note: The ‘submit XML to gang run task' 
allows a <Rotation> node to control the 
rotation angle per graphic
Note: The gang run view shows an extra 
column containing the rotation setting 
for each entry in the queue
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Extend content in the prepare graphics for nesting task

●  Using Extend content, you can mirror the graphic content over the 4 sides and corners of the 
original cut path, and extend the cut path. This can be used to create a hem for a flag,               
a banner, a canvas, ….
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File info on jobs in the gang run printing view 

•  An info button was added to 
the gang run printing 
view. This button is only 
enabled when one file is 
selected. Clicking on this 
button will open the file info 
dialog. The dialog can also 
be opened by using the 
shortcut ctrl-i (cmd-i on 
Mac) or by choosing the 
menu item File > Info.



56 

Imposition automation
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New Change Imposition Layout Task

●  The ‘change imposition Layout task’ allows you to change the way the imposition is positioned 
relatively to the paper and plate. This means this task will typically be used when changes on 
the press need to be made.
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New Change Imposition Layout Task

Changing the plate parameters

•  The plate tab allows you to 
define the plate sizes as well as 
the positioning of the sheet 
(paper) on the plate.


Note: If you do not want to change 
the plate size or sheet offsets, then 
leave these settings to the default 
settings, they contain the 
corresponding SmartNames. 
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New Change Imposition Layout Task

Changing the sheet parameters

•  The sheet tab allows you to 
define the sheet (paper) 
sizes and position your 
imposition on the sheet.

•  The gripper-margin field 
allows you to redefine the 
gripper-margin 
SmartName for the selected 
sheet or imposition.

•  The Backing Up drop-down 
box allows you to 
accommodate for a change 
in working method of your 
printing press. 
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Re-center pages on Trim Box 

●  If, while importing a JDF layout imposition, you want to reposition the pages according to 
their Trim Box, then switch this toggle ON. If you want to leave the pages positioned relative to 
their Media Box, which is according to the JDF specification, then switch this toggle OFF.

●  Which option to use is dependent on the impositioning and page workflow you are using.
●  When in doubt, start by setting the toggle ON, and check the page positioning in the resulting 

Imposition.
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Various features
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Grids in workflow canvas

●  To use the grid, go to View > Show Grid.
●  To hide the grid, go to View > Hide Grid.
●  To snap workflow blocks to the grid when moving them, choose View > Snap to Grid.
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Load Parameters for Repeating Content from XML

How to load parameters for repeating content from XML in the Map Data task?
●  Place the text insertion cursor in the repeating block for which you want to load parameters. 

Note: the repeating block should represent a repeating XML element in an XML input file.
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Load Parameters for Repeating Content from XML

How to load parameters for repeating content from XML in the Map Data task?
●  Select Load Parameters from File... from the action pop-up menu at the bottom of the list of 

parameters. The Load Parameters from File dialog will pop up.
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Load Parameters for Repeating Content from XML

How to load parameters for repeating content from XML in the Map Data task?
●  Specify the relative XPath Expression to the XML element in the repeating XML element in the 

input XML file to load parameters from.
●  You can automatically generate the XPath expression by selecting the XML element to load 

parameters from the example file you selected for the input XML file. To do this, click 
the Edit button at the bottom of the XPath Expression field.

●  You can choose to load parameters from the repeating XML element itself. To do this, leave the 
XPath Expression field blank.
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Load Parameters for Repeating Content from XML

How to load parameters for repeating content from XML in the Map Data task?
●  Click OK to load parameters from the the repeating XML element in the input XML file. 

Parameters will be added for every child XML element of the selected XML element and for 
all of their XML attributes.
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Improved UI for the Data Splitter workflow control 

●  The Edit Parameters dialog of the Data Splitter workflow control has a new and more easy-to-
use user interface. The Data Splitter workflow control can be used to process each file of a file 
set individually. By default, files will be processed one by one. However, you can choose to 
output the files in groups by selecting the Grouped option.
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Sort on modification date in the Sort workflow control

●  It is now possible to sort on the modification date of the input files by choosing "modification 
date" in the sort by combo box. E.g. to find the most recent files / folders.
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Improved handling of conditional queries in Split XML

●  When splitting on an XPath expression /Jobs/Job[@ready='y'], where a file contains the 
following:

<Jobs>
          <Job id='1' ready='y'/>
          <Job id='2' ready='n'/>
          <Job id='3' ready='y'/>

</Jobs>

●  The ‘split XML task’ will produce 2 files, with only the selected node where before both files also 
unexpectedly contained the non-selected node with id 2.
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Improved UI for deprecated tasks

●  A task is flagged as 'soon outdated' in the workflow canvas:

●  The options panel of a ‘soon outdated’ task will contain following banner at the top:

●  Tickets view indicates ‘soon outdated’ tickets:
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Search in Job Parameters

●  The Parameters tab in the Job Setup dialog now has a search field. The search field allows 
the user to search on Scope, Name and Value.
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Layer info for Adobe PDF files 

●  The info dialog in the Pilot now shows layer information for Adobe PDF files. The Router 
Workflow Control can now also route on layer names for Adobe PDF files, identical as for 
Normalized PDF files
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